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1 Introduction
This manual is intended to aid the process of installing and setting up the
EMT as tailored for use on the Williams International FJ44-2A engine
during field service. The detailed descriptions of each EMT feature or
how to use them are available on the EMT as on-line help. This manual
contains instructions on how you can get to the EMT on-line help.

Warning
Read this entire manual and all other publications pertaining to the work
to be performed before installing, operating, or servicing this equipment.
Practice all plant and safety instructions and precautions. Failure to
follow instructions can cause personal injury and/or property damage.

Product Review
This FJ44-2A EMT is designed to acquire, modify, and record data from
the FJ44 engine's Electronic Control Unit (ECU) during in-service flight of
an Electronic Fuel Control Unit (EFCU) system.

The FJ44-2A EMT implements security measures to tailor the full EMT
functionality for applicable users. For more information about what
features are available, see section titled EMT Features.

User Interface
The EMT user interface is designed to standardize with other Windows
application programs. You can use all the Windows features that you are
used to such as opening, moving, resizing, minimizing and maximizing
windows. If you are not familiar with any of the Windows features, please
refer to the Microsoft Windows User’s Guide or Microsoft Windows
On-line Help.

Hardware and Software Requirements
The EMT has the following minimum requirements:

• IBM-compatible 486-100 CPU or greater.

• Minimum software operating environment: DOS 6.2 with Windows
3.1x or Windows 95.

• 8MB RAM

• One 16550 UART serial port.

• TurboCom/2 software (required for operating EMT at high speed
under Windows 3.1x)

• Minimum 640x480 VGA display

• 200MB hard drive

• CD-ROM (For installing software)

• Pointing device such as mouse, trackball, etc.
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Conventions
This manual uses the following conventions to identify certain types of
information.

Convention Description

Menu Command Indicate menu.

Type Text Indicate text to be typed.

Italics Indicate title of a chapter, section or even
another document.

SHIFT+CTRL Indicate keys on the keyboard. The plus sign
(+) indicates that you should hold down the
first key while pressing the second.

Abbreviations and Acronyms
This manual uses the following abbreviations and acronyms.

ECU Electronic Control Unit

EFCU Engine Fuel Control Unit

EMT Electronic Maintenance Terminal

IBM International Business Machines®

PC IBM Compatible Personal Computer

MB Megabytes

RAM Random Access Memory

UART Universal Asynchronous Receiver/Transmitter

S/N Serial Number
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2 Getting Started
Introduction

This chapter explains how to install the EMT and to remove it from your
systems. It also describes the steps the setup program will undertake
during the installation process.

Installing EMT
To Install EMT, you must have Microsoft Windows running.

To Begin Setup from Microsoft Windows 3.1x
1. Insert the EMT installation diskette/Compact Disk (CD).

2. Select the Windows Program Manager or File Manager.

3. Choose Run from the File menu.

4. Browse for the diskette/CD-ROM Drive.

5. Select and open SETUP.EXE.

6. Select OK in the Run Command Line box.

To Begin Setup from Microsoft Windows 95
1. Insert the EMT installation diskette/CD.

2. Choose Run from the Start button on the Taskbar.

3. Browse for the diskette/CD-ROM Drive.

4. Select and open SETUP.EXE.

5. Select OK in the Run Command Line box.

Installation Overview
The setup program will do the following steps during the installation
process.
1. Display the version number and the Woodward part number of the

EMT you are installing. If this is the incorrect EMT version, click the
Cancel button to quit the setup program.

2. Prompt you for the group name where the icons will be created. The
default is WGC Applications. You can type a new group name or
select an existing group from the list button.

3. Prompt you for the location for the EMT files with the default location
of the EMT. You can change the location if you wish to install the
EMT into a different location.

Note: If you are upgrading, then you must use the existing EMT
directory.

4. Check for adequate free space on the drive you have chosen.

5. Copy the EMT files to the location you have chosen.

6. Create icons in the group you have specified in step 2 in the Program
Manager (Windows 3.1x) or the Start Menu (Windows 95).

7. Display the README.TXT file.

If you are just upgrading the EMT, you may start the EMT by double
clicking on the EMT icon in the WGC Applications group window.
Otherwise, for a new EMT installation you must first install an ECU build
before running the EMT.



Electronic Maintenance Terminal Manual 91378

6 Woodward

Installing ECU Builds
If this is the first time you are setting up your system for the EMT, you
need to install an ECU build. To install the ECU build, follow the
instructions for installing the EMT but use the ECU build installation
diskette/CD instead.

Important: You must specify the same location in which the EMT is
installed.

Uninstalling EMT
The setup program installs an icon for removing the EMT from your
system. To remove the EMT, double click on the icon.

Note: The uninstall process does not remove any of the ECU builds from
the system. Remove the ECU builds first using the EMT's Remove ECU
Configuration feature (see online help for more information) before
uninstalling the EMT.

Where To Go From Here
If you are installing the EMT for the first time, you might need to configure
the communication port (serial port) that the EMT uses to interact with the
ECU. The default serial port is COM 1. If you wish to use another serial
port, please refer to Configuring EMT section below. However, if you are
new to the EMT or unfamiliar with the EMT startup procedure, please
proceed to the next chapter entitled EMT Overview first.

Configuring the EMT
The EMT uses the PC's serial COM port to communicate with the ECU.
Appendix B shows the pin layout of the COM port.

Setting the COM port
1. Double click on the EMT icon in the WGC Applications group to start

the program.

2. Chose the Select Com Port subcommand of the Admin Utilities under
Utilities menu. A dialog with a choice of COM ports will appear.

Note: You must have the proper password level in order to select
the menu. Otherwise, it is grayed out.

3. Select the COM port that is to be used for communicating with the
ECU. It will not allow you to select a COM port that is already used
by another device such as a mouse, modem, etc.

Installing TurboCom/2
The EMT requires the TurboCom/2 software in order to operate at high
speed (communicating with the ECU at 115.2Kbps) under Windows 3.1x.
This software is not required if the PC operating system is Windows 95.

To install TurboCom/2:

1. Insert the TurboCom/2 diskette into a floppy drive.

2. Select the Windows Program Manager or File Manager.

3. Choose Run from the File menu.

4. Type A:\SETUP.EXE in the Command Line box.

For further information, please refer to the TurboCom/2 User's Guide.
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3 EMT Overview
Introduction

This chapter explains the start up procedure of the EMT. It also
describes how you can get more help about the EMT or the task at hand
while running the EMT.

Starting EMT
To run the EMT from any Windows system, double click on the EMT icon
(shown on the left) on the WGC Applications group created by the setup
program. (see section Installation Overview on page 5). In Windows
95 you may run the application from the Start Menu: click on Programs,
then WGC Applications, then click on EMT.

The EMT can load the appropriate ECU build configuration files upon
connecting to the ECU. This feature uses the part number of the ECU
Control software. However, if the matching ECU build is not installed in
the system or connection could not be established within a certain
amount of time, the EMT will display the cause of failure and then quits.

Startup Overview
The EMT startup procedure is as follows.
1. Establish connection with the ECU.

2. Get the part number of the ECU Control software.

3. Match the part number of the ECU Control software with all the ECU
builds installed in the system.

4. If a match is found, then it loads configuration files of that matching
ECU build.

- otherwise -

If no match is found or fail to connect to the ECU within allocated
time, the EMT will take the following actions.

i. Display the reason for failing to select the appropriate ECU
configuration.

ii. Ask the user to choose an ECU software build to be uploaded.

5. Log into Level 1 (see section below, EMT Features).

EMT Features
As mentioned at the beginning of this manual, the EMT features are
documented in the on-line help. If you have not used an on-line help
before or are unfamiliar with the EMT help system, please proceed to the
section entitled Getting Help below.

The table on Pages 7 thru 10 summarizes the features available at a
particular password level.

The following are the default passwords (non case sensitive):
• Level 1 - tech
• Level 2 - admin
• Level 3 - bill

Remember to change these passwords immediately after installation.
Refer to the on-line help for instructions to change password.
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Features
No

Password
Level

1
Level

2
Level

3

Utilities:

Change Password Y

Validate EMT Files

Remove ECU Configurations Y

Change COM Port Y Y Y

Change File Location Y Y Y

Upload:

RAM Y Y Y

Build Y Y Y

Bootstrap Y Y Y

ECU Information:

Change Fan Cycle Count Y Y

Change Flight Cycle Count Y Y

Change Flight Number Y Y

Change High-pressure Compressor Cycle
Count

Y Y

Change High-pressure Turbine Cycle
Count

Y Y

Change Low-pressure Turbine Cycle Count Y Y

Change Takeoff Count Y Y

Change Serial Number Y Y

Change ECU Run Time Y Y

Read Fan Cycle Count Y Y

Read Flight Cycle Count Y Y

Read Flight Number Y Y

Read High-pressure Compressor Cycle
Count

Y Y

Read High-pressure Turbine Cycle Count Y Y

Read Low-pressure Turbine Cycle Count Y Y

Read Takeoff Count Y

Read Serial Number Y Y Y

Read ECU Run Time Y Y

Variable Monitoring:

Limited Y Y
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Features
No

Password
Level

1
Level

2
Level

3

Text Y1 Y

Bar Graph Y

Strip Chart Y

Variable Modification

Data Logging:

Limited Y Y

Normal Y

Remote

Maintenance Data Display (BIT):

Read Y Y Y

Clear Y Y Y

Save Y Y Y

BIT Disable

Read Y

Modify Y

Circuit Trim Values

(Read Only) Y

Circuit Trim Schedule

Read from ECU Y

Write to ECU Y

Control Law Schedule:

Read from ECU Y

Write to ECU Y

Transient Records:

Read

Clear

Save

1 Only CED_PLA and MIN_PLA are available.
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Features
No

Password
Level

1
Level

2
Level

3

Trend Records:

Read Y Y Y

Clear Y Y

Save Y Y Y

Exceedence Records:

Read Y Y Y

Clear Y Y

Save Y Y Y

Getting Help
The EMT has an on-line Help system, similar to other Windows
application programs. You can get help about the EMT or the task you
are working on. If you are unfamiliar with the Windows Help, you can
choose Using Help from the Help menu of the EMT main window.

Get Help About EMT
1. If the EMT main window is not active, click in the EMT main

application window.

2. Press the F1 key or select Index from the Help menu. This brings up
the contents of the help reference.

Get Help About the Task At Hand
1. Click in the window that you want help on if it is not already active.

2. Press the F1 key. This brings up the help for the active window.

Note: The F1 key not only applies to windows, it also applies to dialogs.
In a dialog, press F1 or select the Help button (if available).

Get Help From the Context-Sensitive Button
1. Click on the button as shown on the left on the toolbar. The cursor

turns into the image of the button.

2. Click on anything you have questions about such as the buttons on
the toolbar or the menu commands.

Shortcut: Pressing SHIFT+F1 is the same as clicking the context-
sensitive button.
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4 Troubleshooting
When problems are encountered when installing the EMT on a PC, first
refer to Appendix A for potential solutions. For any additional problems
or issues encountered with installation or other use of the EMT, utilize the
following Problem Report form for documenting the problem for Williams
International.



Electronic Maintenance Terminal Manual 91378

12 Woodward

EMT Problem Report

Title:
___________________________________________________

EMT Version # (from “About EMT” screen): _______________

EMT Part # (from “About EMT” screen): _______________
Selected ECU Configuration (from “About EMT” screen):

____________________________________________
PC System Processor-type: __________ PC System
Memory: ___________ MB

Operating System: ___ Windows 3.x ___Windows 95

Problem Description:

Requested By: ______________________ Date: _________

Return completed form to:
Customer Support Manager
c/o Williams International
2280 W. Maple
PO Box 200
Walled Lake, Michigan
48390
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Appendix A Installation Questions

Q1. The EMT flashes and quits when I run the program.

The EMT is not configured for any ECU builds. Make sure you install at
least one ECU build after installing the EMT for the first time in your
system. Please refer to chapter 2 on Getting Started.

Q2. Can I install the ECU builds first before installing the EMT?

No. You must install the EMT first before installing any ECU builds.

Q3. Can I move the ECU builds into another directory?

No - see Q4.

Q4. I moved the ECU build into another directory. When I run the
EMT program, I get an error message saying that the EMT files
has been found to be invalid and contact the EMT
administrator.

Once you have installed an ECU build into a location of your choice
during installation, you cannot move the ECU build files to another
location. If you want to move an ECU build to another directory, you
would have to remove the ECU build first and then re-install it again into
that directory. Refer to How do I remove an ECU build on the EMT on-
line help for more details on removing an ECU build.

Q5. I have tried everything as instructed in the manual but still fail
to run the EMT.

Try starting all over again.
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Appendix B RS-232 Serial Port Layout

The EMT uses only pins 2, 3, and 5 for communicating with the ECU.

1 2 3 4 5

9876

Figure 1. Pin numbers of the serial port.

Pin Signal I/O Definition

1 DCD I Data carrier detect

2 SIN I Serial input

3 SOUT O Serial output

4 DTR O Data terminal
ready

5 GND N/A Signal ground

6 DSR I Data set ready

7 RTS O Request to sent

8 CTS I Clear to send

9 RI I Ring indicator

Table 1. Pin assignments for the serial port.2

2
From the User’s Guide of a Dell XPS 486 systems. It should equally apply to any IBM

compatible systems.
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How to Contact Woodward

In North America use the following address when shipping or corresponding:
Woodward Governor Company
PO Box 7001
5001 North Second Street
Rockford, IL 61125-7001, USA

Telephone—+1 (815) 877-7441 (24 hours a day)
Toll-free Phone (in North America)—1 (800) 523-2831
Fax—+1 (815) 639-6033

You can also contact the Woodward Customer Service Department or consult
our worldwide directory on Woodward’s website (www.woodward.com) for the
name of your nearest Woodward distributor or service facility. [For worldwide
directory information, go to
http://www.woodward.com/AES/overview/locations.cfm]

Engineering Services

Woodward AES Engineering Services offers the following after-sales support
for Woodward products. For these services, you can contact us by telephone, by
e-mail, or through the Woodward website.

• Technical Support !
• Customer Training
• Field Service

Contact information:
Telephone—+1 (815) 877-7441
Toll-free Phone (in North America)—1 (888) 273-8817
E-mail—woodward@woodward.com
Website—www.woodward.com/aes



We appreciate your comments about the content of our publications.

Send comments to: woodward@woodward.com

Please include the manual number from the front cover of this publication.

Woodward/Aircraft Engine Systems
PO Box 7001, Rockford IL 61125-7001, USA

5001 North Second Street Rockford IL 61125, USA
Phone +1 (815) 877-7441 • Fax +1 (815) 639-6033

E-mail and Home Page—www.woodward.com

Woodward has company-owned plants, subsidiaries, and branches,
as well as authorized distributors and other authorized service and sales facilities throughout the world.

Complete address/phone/fax/e-mail information for all locations is available on our website.


